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Department of AERONAUTICAL ENGIERRING 

Vision 

 Department of Aeronautical Engineering aims to be indispensable source in 

Aeronautical Engineering which has a zeal to provide the value driven 

platform for the students to acquire knowledge and empower themselves to 

shoulder higher responsibility in building a strong nation.. 

 

Mission 

 The primary mission of the department is to promote engineering education and 

research. To strive consistently to provide quality education, keeping in pace with 

time and technology. Department passions to integrate the intellectual, spiritual, 

ethical, and social development of the students for shaping them into dynamic 

engineers. 

 
 

QUALITY POLICY 

 Impart up-to date knowledge to the students in Aeronautical area to make them 

quality engineers.Make the students experience the applications on quality 

equipment and tools.Provide systems, resources, and training opportunities to 

achieve continuous improvement.Maintain global standards in education, training, 

and services. 
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PROGRAM OUTCOMES 
(PO’s) 

Engineering Graduates will be able to: 

 Engineering knowledge: Apply the knowledge of mathematics, science, engineering 

fundamentals, and an engineering specialization to the solution of complex 

engineering problems. 

 Problem analysis: Identify, formulate, review research literature, and analyze 

complex engineering problems reaching substantiated conclusions using first 

principles of mathematics, natural sciences, and engineering sciences. 

 Design / development of solutions: Design solutions for complex engineering 

problems and design system components or processes that meet the specified 

needs with appropriate consideration for the public health and safety, and the 

cultural, societal and environmental considerations. 

 Conduct investigations of complex problems: Use research-based knowledge and 

research methods including design of experiments, analysis and interpretation of 

data, and synthesis of the information to provide valid conclusions. 

 Modern tool usage: Create, select, and apply appropriate techniques, resources, 

and modern engineering and IT tools including prediction and modeling to complex 

engineering activities with an understanding of the limitations. 

 The engineer and society: Apply reasoning informed by the contextual knowledge 

to assess societal, health, safety, legal and cultural issues and the consequent 

responsibilities relevant to the professional engineering practice. 

 Environment and sustainability: Understand the impact of the professional 

engineering solutions in societal and environmental contexts, and demonstrate the 

knowledge of, and need for sustainable development. 
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 Ethics: Apply ethical principles and commit to professional ethics and 

responsibilities and norms of the engineering practice. Individual and team work: 

Function effectively as an individual, and as a member or leader in diverse teams, 

and in multidisciplinary settings. 

 Communication: Communicate effectively on complex engineering activities with 

the engineering community and with society at large, such as, being able to 

comprehend and write effective reports and design documentation, make effective 

presentations, and give and receive clear instructions. 

  Project management and finance: Demonstrate knowledge and understanding of 

the engineering and management principles and apply these to one’s own work, as 

a member and leader in a team, to manage projects and in multi disciplinary 

environments. 

 Life- long learning: Recognize the need for, and have the preparation and ability to 

engage in independent and life-long learning in the broadest context of 

technological change. 
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PROGRAM EDUCATIONAL OBJECTIVES – Aeronautical Engineering 

 PEO1 (PROFESSIONALISM & CITIZENSHIP): To create and sustain a community of learning 

in which students acquire knowledge and learn to apply it professionally with due 

consideration for ethical, ecological and economic issues. 

 PEO2 (TECHNICAL ACCOMPLISHMENTS): To provide knowledge based services to satisfy 

the needs of society and the industry by providing hands on experience in various 

technologies in core field. 

 PEO3 (INVENTION, INNOVATION AND CREATIVITY): To make the students to design, 

experiment, analyze, and interpret in the core field with the help of other multi 

disciplinary concepts wherever applicable. 

 PEO4 (PROFESSIONAL DEVELOPMENT): To educate the students to disseminate research 

findings with good soft skills and become a successful entrepreneur. 

 PEO5 (HUMAN RESOURCE DEVELOPMENT): To graduate the students in building national 

capabilities in technology, education and research 

PROGRAM SPECIFIC OUTCOMES – Aeronautical Engineering 

 To mould students to become a professional with all necessary skills, personality and 

sound knowledge in basic and advance technological areas. 

 To promote understanding of concepts and develop ability in design manufacture and 

maintenance of aircraft, aerospace vehicles and associated equipment and develop 

application capability of the concepts sciences to engineering design and processes. 

 Understanding the current scenario in the field of aeronautics and acquire ability to apply 

knowledge of engineering, science and mathematics to design and conduct experiments in 

the field of Aeronautical Engineering. 

 4. To develop leadership skills in our students necessary to shape the social, intellectual, 

business and technical worlds. 
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INTRODUCTION 

ANSYS is a general purpose finite element modelling package for numerically solving 

a wide variety of mechanical problems. These problems include: static/dynamic structural 

analysis (both linear and non-linear), heat transfer and fluid problems, as well as acoustic and 

electro-magnetic problems. 

In general, a finite element solution may be broken into the following three stages. This is a 

general guideline that can be used for setting up any finite element analysis. 

 
1. Pre-processing: defining the problem; the major steps in pre-processing are given 

below: 

 Define key points/lines/areas/volumes 

 Define element type and material/geometric properties 

 Mesh lines/areas/volumes as required. 

 
The amount of detail required will depend on the dimensionality of the analysis (i.e. 

1D, 2D, axi-symmetric, 3D). 

 

2. Solution: assigning loads, constraints and solving; here we specify the loads (point 

or pressure), constraints (translational and rotational) and finally solve the resulting set 

of equations. 

 

3. Postprocessing: further processing and viewing of the results; in this stage one may 

wish to see: 

o Lists of nodal displacements 

o Element forces and displacements 

o Deflection plots 

o Stress contour diagrams 
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1. ANSYS 13.0 Environment 

The ANSYS Environment for ANSYS 13.0 contains 2 windows: the Main Window and an 

Output Window. Note that this is somewhat different from the previous version of ANSYS 

which made use of 6 different windows. 

1. Main Window 
 

 
a. Utility Menu 

The Utility Menu contains functions that are available throughout the ANSYS 

session, such as file controls, selections, graphic controls and parameters. 

b. Input Window 

The Input Line shows program prompt messages and allows you to type in 

commands directly. 

c. Toolbar 

The Toolbar contains push buttons that execute commonly used ANSYS 

commands. More push buttons can be added if desired. 

d. Main Menu 

The Main Menu contains the primary ANSYS functions, organized by 

preprocessor, solution, general postprocessor, design optimizer. It is from this 

menu that the vast majority of modelling commands are issued. This is where 

you will note the greatest change between previous versions of ANSYS and 

version 7.0. However, while the versions appear different, the menu structure 

has not changed. 
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e. Graphics Window 

The Graphic Window is where graphics are shown and graphical picking can 

be made. It is here where you will graphically view the model in its various 

stages of construction and the ensuing results from the analysis. 
 

2. Output Window 
 

The Output Window shows text output from the program, such as listing of data etc. It 

is usually positioned behind the main window and can de put to the front if necessary. 

 
2. ANSYS FILES 

 

INTRODUCTION 

A large number of files are created when you run ANSYS. If you started ANSYS without 

specifying a jobname, the name of all the files created will be FILE.* where the * represents 

various extensions described below. If you specified a jobname, say Frame, then the created 

files will all have the file prefix, Frame again with various extensions: 

frame.db 

Database file (binary). This file stores the geometry, boundary conditions and any 

solutions. 

frame.dbb 

Backup of the database file (binary). 

frame.err 

Error file (text). Listing of all error and warning messages. 

frame.out 
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Output of all ANSYS operations (text). This is what normally scrolls in the output 

window during an ANSYS session. 

frame.log 

Logfile or listing of ANSYS commands (text). Listing of all equivalent ANSYS 

command line commands used during the current session. 

etc... 

Depending on the operations carried out, other files may have been written. These files may 

contain results, etc. 

 

3. Plotting ANSYS Results to a File 
 

PLOTTING OF FIGURES 

There are two major routes to get hardcopies from ANSYS. The first is a quick a raster-based 

screen dump, while the second is a scalable vector plot. 

Quick Image Save 

When you want to quickly save an image of the entire screen or the current 'Graphics window', 

select: 

 'Utility menu bar'/'PlotCtrls'/'Hard Copy ...'.

 In the window that appears, you will normally want to select 'Graphics window', 

'Monochrome', 'Reverse Video', 'Landscape' and 'Save to:'.

 Then enter the file name of your choice.

 Press 'OK'

This raster image file may now be printed on a PostScript printer or included in a document. 

Display and Conversion 

The plot file that has been saved is stored in a proprietary file format that must be converted 

into a more common graphic file format like PostScript, or HPGL for example. This is 

performed by running a separate program called display. To do this, you have a couple of 

options: 

1. Select display from the ANSYS launcher menu (if you started ANSYS that way) 

2. Shut down ANSYS or open up a new terminal window and then type display at the 
Unix prompt. 

Either way, a large graphics window will appear. Decrease the size of this window, because it 

most likely covers the window in which you will enter the display plotting commands. Load 

your plot file with the following command: 

file,frame,pic 

if your plot file is 'plots.pic'. Note that although the file is 'plots.pic' (with a period), Display 

wants 'plots,pic'(with a comma). You can display your plots to the graphics window by issuing 

the command like 

plot,n 
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where n is plot number. If you plotted 5 images to this file in ANSYS, then n could be any 

number from 1 to 5. 

 
Now that the plots have been read in, they may be saved to printer files of various formats: 

 
1. Colour PostScript: To save the images to a colour postscript file, enter the following 

commands in display: 

2. pscr,color,2 

3. /show,pscr 

4. plot,n 

 
Where n is the plot number, as above. You can plot as many images as you want to 

postscript files in this manner. For subsequent plots, you only require the plot,n 

command as the other options have now been set. Each image is plotted to a postscript 

file such as pscrxx.grph, where xx is a number, starting at 00. 

 
Note: when you import a postscript file into a word processor, the postscript image 

will appear as blank box. The printer information is still present, but it can only be 

viewed when it's printed out to a postscript printer. 

 
Printing it out: Now that you've got your color postscript file, what are you going to 

do with it? Take a look here for instructions on colour postscript printing at a couple 

of sites on campus where you can have your beautiful stress plot plotted to paper, 

overheads or even posters! 

 
5. Black & White PostScript: The above mentioned colour postscript files can get very 

large in size and may not even print out on the postscript printer in the lab because it 

takes so long to transfer the files to the printer and process them. A way around this is 

to print them out in a black and white postscript format instead of colour; besides the 

colour specifications don't do any good for the black and white lab printer anyways. 

To do this, you set the postscript color option to '3', i.e. and then issue the other 

commands as before 

6. pscr,color,3 

7. /show,pscr 

8. plot,n 

 

 

 

 

 

 

 
4.    MECHANICAL APDL DOCUMENTATION DESCRIPTIONS 

 

The manuals listed below form the ANSYS product documentation set. They include 

descriptions of the procedures, commands, elements, and theoretical details needed to use 

ANSYS. A brief description of each manual follows. 
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Advanced Analysis Techniques Guide: Discusses techniques commonly used for complex 

analyses or by experienced ANSYS users, including design optimization, manual rezoning, 

cyclic symmetry, rotating structures, submodeling, substructuring, component mode 

synthesis, and cross sections. 

 
ANSYS Connection User's Guide: Gives instructions for using the ANSYS Connection 

products, which help you import parts and models into ANSYS. 

 
ANSYS Parametric Design Language Guide: Describes features of the ANSYS Parametric 

Design Language (APDL), including parameters, array parameters, macros, and ways to 

interface with the ANSYS GUI. Explains how to automate common tasks or to build your 

model in terms of parameters. Includes a command reference for all APDL-related 

commands. 

 
Basic Analysis Guide: Describes general tasks that apply to any type of analysis, including 

applying loads to a model, obtaining a solution, and using the ANSYS program's graphics 

capabilities to review results. 

 
Command Reference: Describes all ANSYS commands, in alphabetical order. It is the 

definitive reference for correct command usage, providing associated menu paths, product 

applicability, and usage notes. 

 
Contact Technology Guide: Describes how to perform contact analyses (surface-to-surface, 

node-to-surface, node-to-node) and describes other contact-related features such as multipoint 

constraints and spot welds. 

 
Coupled-Field Analysis Guide: Explains how to perform analyses that involve an interaction 

between two or more fields of engineering. 

 
Distributed ANSYS Guide: Explains how to configure a distributed processing environment 

and proceed with a distributed analysis. 

 
Element Reference: Describes all ANSYS element, in numerical order. It is the primary 

reference for correct element type input and output, providing comprehensive descriptions for 

every option of every element. Includes a pictorial catalog of the characteristics of each 

ANSYS element. 

 

Modeling and Meshing Guide: Explains how to build a finite element model and mesh it. 
 

Multibody Analysis Guide: Describes how to perform a multibody simulation to analyze the 

dynamic behavior of a system of interconnected bodies comprised of flexible and/or rigid 

components. 

 
Operations Guide: Describes basic ANSYS operations such as starting, stopping, interactive 

or batch operation, using help, and use of the graphical user interface (GUI). 

 
Performance Guide: Describes factors that impact the performance of ANSYS on current 

hardware systems and provides information on how to optimize performance for different 

ANSYS analysis types and equation solvers. 
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Rotordynamic Analysis Guide: Describes how to perform analysis of vibrational behavior in 

axially symmetric rotating structures, such as gas turbine engines, motors, and disk drives. 

 
Structural Analysis Guide: Describes how to perform the following structural analyses: static, 

modal, harmonic, transient, spectrum, buckling, nonlinear, material curve fitting, gasket joint 

simulation, fracture, composite, fatigue, p-method, beam, and shell. 

 
Theory Reference for the Mechanical APDL and Mechanical Applications: Provides the 

theoretical basis for calculations in the ANSYS program, such as elements, solvers and 

results formulations, material models, and analysis methods. By understanding the underlying 

theory, you can make better use of ANSYS capabilities while being aware of assumptions 

and limitations. 

 

Thermal Analysis Guide: Describes how to do steady-state or transient thermal analyses. 
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EXPERIMENT: 1 

TWO DIMENSIONAL STATIC LINEAR ANALYSIS OF A 

CANTILEVER BEAM 
 

 

 BENDING OF UNIFORM CANTILEVER BEAM 

 
AIM: To determine the stresses acting on a cantilever beam with a point load of -10000 N 

acting at one of its ends and perpendicular to the axis of the beam. 

 Young’s modulus = 2e5 

 Poisson’s ratio = 0.3 

 Length of the beam = 2m = 2000mm 

 Breadth of the beam = 10 cm = 100mm 

 Height of the beam = 50mm 
 

PROCEDURE: 

PRE PROCESSING 

STEP 1: From the Main menu select preferences 

Select structural and press OK 

STEP 2: From the main menu select Pre-processor 

Element type  Add / edit/Delete  Add  BEAM – 2D Elastic 3  Apply  Close 

Material properties  material models  Structural  Linear  Elastic  Isotropic 

EX = 2e5; PRXY = 0.3 

STEP 3: From the main menu select Pre-processor 

Sections  Beam  Common Sections  Select subtype as Rectangular section 

Enter B = 100, H = 50  Apply  Preview 

Real constants  Add  Add  Ok  Geometric Properties  Area = 5000, Izz = 

4170000, Height = 50  Ok  Close 

STEP 4: From the main menu select Pre-processor  Modelling 

 Create the key points in the Workspace 

Create  Key points  in active CS

 

 

 
Click APPLY to all the points and for the last point click OK 

X 0 2000 

Y 0 0 
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 Create LINES using the Key points

Create  Lines  Lines  Straight Line  Click on Key points to generate lines 

Select Plot controls from menu bar  Capture image  file save as and save your file 

Figure: Model 

 
STEP 4: Meshing the Geometry 

From the main menu select Meshing 

Meshing  Size controls  Manual size  Lines  All lines – Number of element 

divisions = 20  Click OK 

Meshing  Mesh  Lines – pick all 
 

Figure: Meshed Model 

SOLUTION PHASE: ASSIGNING LOADS AND SOLVING 

STEP 5: From the ANSYS main menu open Solution 

Solution  Analysis type  new analysis – Static 

STEP 6: Defining loads at the Key points 

Solution  Define Loads  Apply  Structural  Displacement  On key points 
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Left end – ALL DOF arrested 

Solution  Define loads  Apply  Structural  Force/moment  On key Points 

Right end – Apply a load of FY = -1000N 

Select Plot controls from menu bar  Capture image  file save as and save your file 
 

Figure: Model with boundary conditions 

STEP 7: Solving the system 

Solution Solve  Current LS 

POSTPROCESSING: VIEWING THE RESULTS 
 

1. Deformation 

From the main menu select General post processing 

General post processing  Plot Results  Deformed Shape 

Select 'Def + undef edge' and click 'OK' to view both the deformed and the undeformed 

object 
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Figure: Deformed and undeformed Model 

 
 Nodal solution 

 

From the Utility menu select PLOT 

PLOT Results Contour plot  Nodal solution – DOF solution – Y component of 

displacement – OK 
 

Figure: Y-Component displacement of the Model 

RESULT: 

Case: 1:- To determine the stresses acting on a cantilever beam with a point load of -10000 

N acting at one of its ends and perpendicular to the axis of the beam. 

1.   DMX = 31.974 

SMN = -31.974 

PROBLEM DEFINITIONS DIFFERENT FROM JNTU TOPICS 

Case: 2:- To determine the stresses acting on a cantilever beam with a point load of -9000 

N acting at one of its ends and perpendicular to the axis of the beam. 

1.   DMX = 28.777 

SMN = -28.777 
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Case: 3:- To determine the stresses acting on a cantilever beam with a point load of -8000 

N acting at one of its ends and perpendicular to the axis of the beam. 

1.   DMX = 25.58 

SMN = -25.58 
 

 
Case: 4:- To determine the stresses acting on a cantilever beam with a point load of -7000 

N acting at one of its ends and perpendicular to the axis of the beam. 

1.   DMX = 22.382 

SMN = -22.382 
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Case: 5:- To determine the stresses acting on a cantilever beam with a point load of -6000 

N acting at one of its ends and perpendicular to the axis of the beam. 

1.   DMX = 19.185 

SMN = -19.185 
 

 

 

 
Case: 6:- To determine the stresses acting on a cantilever beam with a point load of -5000 

N acting at one of its ends and perpendicular to the axis of the beam. 

1.   DMX = 15.988 

SMN = -15.988 
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EXERCISE PROBLEM 

1) To perform static analysis on cantilever beam for different loadings with following 

specifications 

Length of the beam (L) = 1m 

Breadth of beam (B) = 0.01m 

Width of the beam (W) = 0.1m 

Loading conditions: 1KN, 10KN, 100KN (concentrated load) 

State the observations on behavior of the deflection of beam 

 

VIVA QUESTIONS 

1. If a cantilever beam has a uniformly distributed load, will the bending moment diagram be 

quadratic or cubic? 

2. Name the element type used for beams? 

3. Define Analysis and its Purpose? 

4. What are the modules in Ansys Programming? 

5. What are the Real Constants & Material Properties in Ansys? Explain? 
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EXPERIMENT: 2 

COMPRESSIVE STRENGTH OF RECTANGULAR STIFFENED 

PLANE PANEL OF UNIFORM CROSS-SECTION 
 

 Compressive strength of rectangular stiffened plane panel. 

 
AIM: To analyze the compressive strength of rectangular stiffened plane panel of uniform 

cross-section which is subjected to a pressure of 12000 Pa. 

 

APPARATUS: Ansys 13.0 

GIVEN DATA: 

 Young’s modulus = 2e11 

 Thickness I=1.2, J=1.2 

 Poisson’s ratio = 0.27 

 Density = 7850kg/m3 
 

PROCEDURE: 
 

PRE PROCESSING 

STEP 1: From the Main menu select preferences 

Select structural→ h-method and press OK 

STEP 2: From the main menu select Pre-processor 

Element type  Add / edit/Delete  Add  select shellelastic 4 node 63ok 

Real constants  Add Addselect type1 shellok 

ThicknessI=1.2, J=1.2ok 

Material properties  material models  Structural  Linear  Elastic  Isotropic 

EX = 2e11; PRXY = 0.27; Density = 7850 

STEP 3: From the main menu select Pre-processor  Modeling 

 Create the key points in the Workspace 

Create  Key points  In active CS 

X Y Z 

0 0 0 

6 0 0 

6 4 0 

0 4 0 
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Click APPLY to all the points and for the last point click OK 

 Create LINES using the Key points 

Create  Lines  Straight Line  select 1-2, 2-3, 3-4, 4-1 Key points to generate lines 

 
STEP 4: Modeling  create  Areas arbitrary by lines  select all four lines  ok 

 

 
STEP 5: Meshing the Geometry 

From the main menu select Meshing 

Meshing  mesh attributes  all areas  select the area  shell  ok 

Meshing  Size controls  Manual size  by areas  all areas  Number of element 

edge length = 1  Click ok 

Meshing  Mesh  areas  mapped  3 or 4 sided  select area  ok 
 

SOLUTION PHASE: ASSIGNING LOADS AND SOLVING 
 

STEP 5: From the ANSYS main menu open Solution 

Solution  Analysis type  new analysis  Static 

STEP 6: Defining loads 

Loads  define loads  Apply  Structural  Displacement  On lines  select 

line 1-2 & 1-4  ok 
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Select  ALL DOF arrested 

Define loads  Apply  Structural  Pressure  select on lines 2-3 & 3-4  ok 

Enter pressure = 12000  ok 

 

STEP 7: Solving the system 

Solution Solve  Current LS 

POSTPROCESSING: VIEWING THE RESULTS 
 

2. Deformation 

From the main menu select General post processing 

General post processing  Plot Results  Deformed Shape 

Select 'Def + undef edge' and click 'OK' to view both the deformed and the undeformed 

object 
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 Nodal solution 

 
From the Utility menu select PLOT 

 
PLOT Results Contour plot  Nodal solution 

 
Result  DOF solution  Y component of displacement  OK 

Result  stress  Von mises stress 

 

 
RESULT: 

 

Case: 1:- To determine the stresses acting on a rectangular plane with a pressure load of 

12000 N acting on the lines 2 & 3. 

DMX = 0.187e-07 

SMX = 939.279 
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PROBLEM DEFINITIONS DIFFERENT FROM JNTU TOPICS 

Case: 2:- To determine the stresses acting on a rectangular plane with a pressure load of 

11000 N acting on the lines 2 & 3 

 

DMX = .224e-07 

SMX = 1127 

Case: 3:- To determine the stresses acting on a rectangular plane with a pressure load of 

10000 N acting on the lines 2 & 3 



CS Lab Manual Dept. of ANE 

23 

 

 

 

 
 

DMX = 0.224e-06 

SMX = 4747 

Case: 4:- To determine the stresses acting on a rectangular plane with a pressure load of 

13000 N acting on the lines 2 & 3 

 

 

DMX = 0.224e-06 

SMX = 1127 

Case: 5:- To determine the stresses acting on a rectangular plane with a pressure load of 

14000 N acting on the lines 2 & 3 
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DMX = 0.224e-06 

SMX = 1127 

Case: 6:- To determine the stresses acting on a rectangular plane with a pressure load of 

15000 N acting on the lines 2 & 3 
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DMX = 0.224e-06 

SMX = 1127 

EXERCISE PROBLEM 
 

1) To perform static analysis on cantilever beam for different loadings with following 

specifications 

Length of the beam (L) = 1m 

Breadth of beam (B) = 0.01m 

Width of the beam (W) = 0.1m 

Loading conditions: 1KN, 10KN, 100KN 

Consider the load to be Uniformly Distributed Load and Explain the behavior of the deflection 

of beam? 

 

VIVA QUESTIONS 
 

 

1. What do you mean by degrees of freedom? 

2. Define key points, lines, nodes, elements? 

3. Can meshing is done after elements are created? 

4. Types of co-ordinate systems? 

5. What is symmetry and types of symmetry? 
 

 

 

 
 

 



CS Lab Manual Dept. of ANE 

26 

 

 

 

 
 

 

 
 

 

 

 
 

 

 
 

 

 
 

 

 

 
 

 

 
 

 

 
 

 

 

 
 

 

 
 

 

 

 
 

 

 
 

 

 
 

 

 

 
 

 

 
 

 

 



CS Lab Manual Dept. of ANE 

27 

 

 

 

 
 

 

 
 

 

 

 
 

 

 
 

 

 
 

 

 

 
 

 

 
 

 

 
 

 

 

 
 

 

 
 

 

 

 
 

 

 
 

 

 
 

 

 

 
 

 

 
 

 

 



CS Lab Manual Dept. of ANE 

28 

 

 

 

 
 

 

 
 

 

 

 
 

 

 
 

 

 
 

 

 

 
 

 

 
 

 

 
 

 

 

 
 

 

 
 

 

 

 
 

 

 
 

 

 
 

 

 

 
 

 

 
 

 



CS Lab Manual Dept. of ANE 

29 

 

 

EXPERIMENT: 3(A) 

a) SHEAR OF STIFFENED THIN WALLED OPEN SECTION BEAM 

 

 

 Shear of stiffened thin walled open section 

 
AIM: To analyze shear of stiffened thin walled open section beam which is subjected to a 

pressure of 50 MPa. 

 

APPARATUS: Ansys 13.0 

GIVEN DATA: 

 Young’s modulus = 0.7e11 

 Thickness I = 1.3, J = 1.3 

 Poisson’s ratio = 0.3 

 Density = 2700 kg/m3 

 
PROCEDURE: 

 

PRE PROCESSING 

STEP 1: From the Main menu select preferences 

Select structural→ h-method and press OK 

STEP 2: From the main menu select Pre-processor 

Element type  Add / edit/Delete  Add  select shellelastic 4 node 

63applysolidquad 4 node 182ok 

Real constants  Add Addselect type1 shellok  enter 

ThicknessI =1.3, J=1.3  ok  close 

Material properties  material models  Structural  Linear  Elastic  Isotropic 

EX = 0.7e11; PRXY = 0.3 & Density = 2700  ok  close 

STEP 3: From the main menu select Pre-processor  Modeling 

 Create the key points in the Workspace 

Create  Key points  In active CS 

X Y Z 

0 0 0 

2 0 0 

2 0.2 0 

0.2 0.2 0 
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0.2 1.8 0 

0.5 1.8 0 

0.5 2 0 

0 2 0 
 

Click APPLY to all the points and for the last point click OK 

 Create LINES using the Key points 

Create  Lines  Straight Line  Select 1-2, 2-3, 3-4, 4-5, 5-6, 6-7, 7-8, 8-1 Key 

points to generate lines 

STEP 4: Modeling  create  Areas  arbitrary by lines  select all four lines  ok 

Modeling  operate  extrude  areas  along normal  select the area  ok 

enter the extrude length as 0.5 

 
Select Plot controls from menu bar  Capture image  file save as and save your file 

 

Figure: Open section beam model 

STEP 5: Meshing the Geometry 

From the main menu select Meshing 

Meshing  mesh attributes  all areas  select the element type  no shell  ok 

Select All volumes select the element type number plane ok 

Meshing  Size controls  Manual size  by areas  all areas  Number of element 

edge length = 0.025  Click ok 

Meshing  Mesh  areas  free  select box type instead of single  select the total 

volume  ok 

 

Select Plot controls from menu bar  Capture image  file save as and save your file 
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Figure: Open section beam meshed model 

SOLUTION PHASE: ASSIGNING LOADS AND SOLVING 

STEP 5: Defining loads 

Loads  define loads  Apply  Structural  Displacement  On areas  select 

the bottom edge  ok  all DOF  ok 

Select  ALL DOF arrested 

Define loads  Apply  Structural  Pressure  on areas  select box type 

(instead of single)  select the top flange  ok 

Enter pressure = 12000  ok 
 

 

Figure: Boundary and operating conditions model 

STEP 6: Solving the system 

Solution Solve  Current LS 
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POSTPROCESSING: VIEWING THE RESULTS 

1. Deformation 

From the main menu select General post processing 

General post processing  Plot Results  Deformed Shape 
 

Select 'Def + undef edge' and click 'OK' to view both the deformed and the undeformed 

object 

 

Figure: Deformed and undeformed model 

 
Nodal solution 

From the Utility menu select PLOT 

PLOT Results Contour plot  Nodal solution 

2. Select DOF solution  X component of displacement  OK 
 

 

Figure: X-Component of displacement model 

 
3. Select stress  XY shear stress 
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Figure: XY shear stress model 

 
4. Select stress  Von mises stress 

 

 

Figure: Von mises stress model 

RESULT: 

Case: 1:- To analyze shear of stiffened thin walled open section beam which is subjected 

to a pressure of 50 MPa. 

1.   DMX = 0.917E-03 

2. DMX = 0.917E-03 

SMN = 0.598E-06 

SMX = 0.902E-03 

3.   DMX = 0.917E-03 

SMN = 0.468E+07 
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SMX = 0.120E+08 

4.   DMX = 0.917E-03 

SMX = 0.563E+08 

 

 
PROBLEM DEFINITIONS DIFFERENT FROM JNTU TOPICS 

 
Case: 2:- To analyze shear of stiffened thin walled open section beam which is subjected 

to a pressure of 51 MPa. 

1. DMX = 0.935E-03 

SMX = 0.574E+08 
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Case: 3:- To analyze shear of stiffened thin walled open section beam which is subjected 

to a pressure of 52 MPa. 

1. DMX = 0.954E-03 

SMX = 0.586E+08 

 
Case: 4:- To analyze shear of stiffened thin walled open section beam which is subjected 

to a pressure of 53 MPa. 

1. DMX = 0.972E-03 

SMX = 0.597E+08 

 
Case: 5:- To analyze shear of stiffened thin walled open section beam which is subjected 

to a pressure of 54 MPa. 

1. DMX = 0.990E-03 

SMX = 0.608E+08 
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Case: 6:- To analyze shear of stiffened thin walled open section beam which is subjected 

to a pressure of 55 MPa. 

1. DMX = 1.08E-03 

SMX = 0.620E+08 
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EXPERIMENT: 3 (B) 

TORSIONAL STRENGTH OF A THIN WALLED OPEN SECTION 

BEAM 
 

 

 TORSION OF STIFFENED THIN WALLED OPEN SECTION 

 
AIM: To analyze Torsion of stiffened thin walled open section beam this is subjected to a pressure 

of 20 MPa. 

 

APPARATUS: Ansys 13.0 

GIVEN DATA: 

 Young’s modulus = 0.7e11 

 Thickness I = 1.3, J = 1.3 

 Poisson’s ratio = 0.3 

 Density = 2700 kg/m3 

 

PROCEDURE: 
 

PRE PROCESSING 

STEP 1: From the Main menu select preferences 

Select structural→ h-method and press OK 

STEP 2: From the main menu select Pre-processor 

Element type  Add / edit/Delete  Add  select shellelastic 4 node 

63applysolidquad 4 node 182ok 

Real constants  Add Addselect type1 shellok  enter 

ThicknessI =1.3, J=1.3  ok  close 

Material properties  material models  Structural  Linear  Elastic  Isotropic 

EX = 0.7e11; PRXY = 0.3 & Density = 2700  ok  close 

STEP 3: From the main menu select Pre-processor  Modeling 

 Create the key points in the Workspace 

Create  Key points  In active CS 

X Y Z 

0 0 0 

2 0 0 
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2 0.2 0 

0.2 0.2 0 

0.2 1.8 0 

0.5 1.8 0 

0.5 2 0 

0 2 0 
 

Click APPLY to all the points and for the last point click OK 

 Create LINES using the Key points 

Create  Lines  Straight Line  Select 1-2, 2-3, 3-4, 4-5, 5-6, 6-7, 7-8, 8-1 Key 

points to generate lines 

STEP 4: Modeling  create  Areas  arbitrary by lines  select all four lines  ok 

Modeling  operate  extrude  areas  along normal  select the area  ok 

enter the extrude length as 0.5 

 
Select Plot controls from menu bar  Capture image  file save as and save your file 

 

 

 

 

 

 

 

 

 

 

 

 
 

Figure: Open section beam model 

STEP 5: Meshing the Geometry 

From the main menu select Meshing 

Meshing  mesh attributes  all areas  select the element type  no shell  ok 

Select all volumes select the element type number plane ok 

Meshing  Size controls  Manual size  by areas  all areas  Number of element 

edge length = 0.025  Click ok 

Meshing  Mesh  areas  free  select box type instead of single  select the total 

volume  ok 
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Figure: Open section beam meshed model 

SOLUTION PHASE: ASSIGNING LOADS AND SOLVING 

STEP 5: Defining loads 

Loads  define loads  Apply  Structural  Displacement  On areas  select 

the front C/S area and select the bottom flange free end area  ok  all DOF  ok 

Select  ALL DOF arrested 

Define loads  Apply  Structural  Pressure  on areas  select the frontal area 

of web and free end area of top flange (20Mpa)  ok 

Define loads  Apply  Structural  Pressure  on areas   select the back end 

area of web (-20 MPa)  ok 

Figure: Boundary and operating conditions model 

STEP 6: Solving the system 

Solution Solve  Current LS 
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POSTPROCESSING: VIEWING THE RESULTS 
 

1. Deformation 

From the main menu select General post processing 

General post processing  Plot Results  Deformed Shape 
 

Select 'Def + undef edge' and click 'OK' to view both the deformed and the undeformed 

object 

 

Figure: Deformed and undeformed model 

Nodal solution 

From the Utility menu select PLOT 

PLOT Results Contour plot  Nodal solution 

2.Select DOF solution  Y component of rotation  OK 

Figure: Y- component of rotation model 

3. Select DOF solution  X component of displacement  OK 
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Figure: X- component of displacement model 

 
4. Select stress  YZ shear stress 

 

 
Figure: YZ shear stress model 

 
5. Select stress  Von mises stress 
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Figure: Von mises stress model 

RESULT: 

Case: 1:- To analyze Torsion of stiffened thin walled open section beam which is subjected 

to a pressure of 20 MPa. 

1.   DMX = 0.108E-04 

2. DMX = 0.108E-04 

SMN = -0.261E-04 

SMX = 0.242E-05 

3.   DMX = 0.108E-04 

SMX = 0.100E-04 

4.   DMX = 0.108E-04 

SMN = 0.187E+07 

SMX = 0.199E+07 

5.   DMX = 0.108E-04 

SMX = 0.258E+08 
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PROBLEM DEFINITIONS DIFFERENT FROM JNTU TOPICS 

 
Case: 2:- To analyze Torsion of stiffened thin walled open section beam which is subjected 

to a pressure of 21 MPa. 

1. DMX = 0.113E-04 

SMX = 0.270E+08 

 
 

 

 
Case: 3:- To analyze Torsion of stiffened thin walled open section beam which is subjected 

to a pressure of 22 MPa. 

1. DMX = 0.119E-04 

SMX = 0.283E+08 
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to a pressure of 23 MPa. 

1. DMX = 0.124E-04 

SMX = 0.295E+08 

 
 

 

 
Case: 5:- To analyze Torsion of stiffened thin walled open section beam which is subjected 

to a pressure of 24 MPa. 

1. DMX = 0.130E-04 

SMX = 0.308E+08 
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Case: 6:- To analyze Torsion of stiffened thin walled open section beam which is subjected 

to a pressure of 25 MPa. 

1. DMX = 0.135E-04 

SMX = 0.321E+08 

 

EXERCISE PROBLEM 

1) Find the compressive strength of a tapered stiffened panel with larger dimension as 0.5m 

and smaller dimension as 0.1m with distance between these dimensions are 1m. 

2)Apply a UDL on a tapered cantilever beam to find out the deflection at free end, for different 

materials, say aluminum and Mild steel. State the observations. 

 

 
VIVA QUESTIONS 

 

1. Define shear flow. 

2. Define Torsion. 

3. Write down the torsion equation. 

4. Define von mises stress. 

5. Define elastic constants. 
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CS Lab Manual Dept. of ANE 

50 

 

 

EXPERIMENT: 3 (C) 

SHEAR FORCE OF STIFFENED THIN WALLED CLOSED SECTION 

BEAM 
 

 

 Shear of stiffened thin walled closed section 

 
AIM: To analyze shear of stiffened thin walled closed section beam which is subjected to a 

pressure of 50 MPa. 

 

APPARATUS: Ansys 13.0 

GIVEN DATA: 

 Young’s modulus = 0.7e11 

 Thickness I = 1.3, J = 1.3 

 Poisson’s ratio = 0.3 

 Density = 2700 kg/m3 

 

PROCEDURE: 
 

PRE PROCESSING 

STEP 1: From the Main menu select preferences 

Select structural→ h-method and press OK 

STEP 2: From the main menu select Pre-processor 

Element type  Add / edit/Delete  Add  select shellelastic 4 node 

63applysolidquad 4 node 182ok 

Real constants  Add Addselect type1 shellok  enter 

ThicknessI =1.3, J=1.3  ok  close 

Material properties  material models  Structural  Linear  Elastic  Isotropic 

EX = 0.7e11; PRXY = 0.3 & Density = 2700  ok  close 

STEP 3: From the main menu select Pre-processor  Modeling 

 Create the key points in the Workspace 

Create  Key points  In active CS 

X Y Z 

0 0 0 

1 0 0 
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0.2 0.2 0 

0.8 0.2 0 

0.2 1.8 0 

0.8 1.8 0 

0 2 0 

1 2 0 
 

Click APPLY to all the points and for the last point click OK 

 Create LINES using the Key points 

Create  Lines  Straight Line  Select 1-2, 2-8, 8-7, 7-1, 3-4, 4-6, 6-5, 5-3 Key 

points to generate lines 

 

STEP 4: Modeling  create  Areas  arbitrary by lines  select all lines  ok 

Modeling  operate  extrude  areas  along normal  select the area  ok 

enter the extrude length as 0.75 

Select Plot controls from menu bar  Capture image  file save as and save your file 

 

Figure: Closed section beam model 

STEP 5: Meshing the Geometry 

From the main menu select Meshing 

Meshing  mesh attributes  all areas  select the element type  no shell  ok 

Select all volumes select the element type number plane ok 

Meshing  Size controls  Manual size  by areas  all areas  Number of element 

edge length = 0.025  Click ok 
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Meshing  Mesh  areas  free  select box type instead of single  select the total 

volume  ok 

 

Select Plot controls from menu bar  Capture image  file save as and save your file 
 

 

Figure: Closed section beam meshed model 

SOLUTION PHASE: ASSIGNING LOADS AND SOLVING 

STEP 5: Defining loads 

Loads  define loads  Apply  Structural  Displacement  On areas  select 

the bottom edge  ok  all DOF  ok 

Select  ALL DOF arrested 

Define loads  Apply  Structural  Pressure  on areas  select surface 

of web  ok 

Enter pressure = 50 MPa  ok 
 

 

Figure: Boundary and operating conditions model 

STEP 6: Solving the system 
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Solution Solve  Current LS 

POSTPROCESSING: VIEWING THE RESULTS 

1. Deformation 

From the main menu select General post processing 

General post processing  Plot Results  Deformed Shape 

 

Select 'Def + undef edge' and click 'OK' to view both the deformed and the undeformed 

object 

 

Figure: Deformed and undeformed model 

 
Nodal solution 

From the Utility menu select PLOT 

PLOT Results Contour plot  Nodal solution 

2. Select DOF solution  Y component of displacement  OK 
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Figure: Y-Component of displacement model 

 
3. Select stress  XZ shear stress 

 

 

Figure: XZ shear stress model 

 
4. Select stress  Von mises stress 

 

 

Figure: Von mises stress model 

RESULT: 

Case: 1:- To analyze shear of stiffened thin walled closed section beam which is subjected 

to a pressure of 50 MPa. 

1.   DMX = 0.001421 

2.   DMX = 0.001421 
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SMN = -0.108E-06 

SMX = 0.517E-03 

3. DMX = 0.001421 

SMN = -0.820E+07 

SMX = 0.820E+07 

4. DMX = 0.001421 

SMX = 0.135E+09 

PROBLEM DEFINITIONS DIFFERENT FROM JNTU TOPICS 

 
Case: 2:- To analyze shear of stiffened thin walled closed section beam which is subjected 

to a pressure of 51 MPa. 

DMX = 0.001383 

SMX = 0.138E+09 
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to a pressure of 52 MPa. 

DMX = 0.00141 

SMX = 0.140E+09 

 
 

 

 
Case: 4:- To analyze shear of stiffened thin walled closed section beam which is subjected 

to a pressure of 53 MPa. 

DMX = 0.001437 

SMX = 0.143E+09 
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Case: 5:- To analyze shear of stiffened thin walled closed section beam which is subjected 

to a pressure of 54 MPa. 

DMX = 0.001464 

SMX = 0.145E+09 

 
 

 

 
Case: 6:- To analyze shear of stiffened thin walled closed section beam which is subjected 

to a pressure of 55 MPa. 

DMX = 0.001491 

SMX = 0.147E+09 
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EXERCISE PROBLEMS 

1) Find the Shear force of a thin walled open section beam for the following 

1. Z Section 

2. T section 
 

Consider flange dimension as 30cms and web dimension as 30cms, and shear force of 30MPa 

consider the material as Aluminum and Steel. State which one will be more efficient to install. 
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EXPERIMENT: 3( D) 

TORSIONAL STRENGTH OF A THIN WALLED CLOSED SECTION 

BEAM 
 

 Shear of stiffened thin walled closed section 
 

AIM: To analyze shear of stiffened thin walled closed section beam which is subjected to a 

pressure of 20 MPa. 

 

APPARATUS: Ansys 13.0 
 

GIVEN DATA: 

 Young’s modulus = 0.7e11 

 Thickness I = 1.3, J = 1.3 

 Poisson’s ratio = 0.3 

 Density = 2700 kg/m3 

 

PROCEDURE: 
 

PRE PROCESSING 

STEP 1: From the Main menu select preferences 

Select structural→ h-method and press OK 

STEP 2: From the main menu select Pre-processor 

Element type  Add / edit/Delete  Add  select shellelastic 4 node 

63applysolidquad 4 node 182ok 

Real constants  Add Addselect type1 shellok  enter 

ThicknessI =1.3, J=1.3  ok  close 

Material properties  material models  Structural  Linear  Elastic  Isotropic 

EX = 0.7e11; PRXY = 0.3 & Density = 2700  ok  close 

STEP 3: From the main menu select Pre-processor  Modeling 

 Create the key points in the Workspace 

Create  Key points  In active CS 

X Y Z 

0 0 0 

1 0 0 

0.2 0.2 0 
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0.8 0.2 0 

0.2 1.8 0 

0.8 1.8 0 

0 2 0 

1 2 0 
 

Click APPLY to all the points and for the last point click OK 

 Create LINES using the Key points 

Create  Lines  Straight Line  Select 1-2, 2-8, 8-7, 7-1, 3-4, 4-6, 6-5, 5-3 Key 

points to generate lines 

 

STEP 4: Modeling  create  Areas  arbitrary by lines  select all lines  ok 

Modeling  operate  extrude  areas  along normal  select the area  ok 

enter the extrude length as 0.75 

Select Plot controls from menu bar  Capture image  file save as and save your file 

 

 
Figure: Closed section beam model 

STEP 5: Meshing the Geometry 

From the main menu select Meshing 

Meshing  mesh attributes  all areas  select the element type  no shell  ok 

Select all volumes select the element type number plane ok 

Meshing  Size controls  Manual size  by areas  all areas  Number of element 

edge length = 0.025  Click ok 

Meshing  Mesh  areas  free  select box type instead of single  select the total 

volume  ok 
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Figure: Closed section beam meshed model 

SOLUTION PHASE: ASSIGNING LOADS AND SOLVING 

STEP 5: Defining loads 

Loads  define loads  Apply  Structural  Displacement  On areas  select 

the bottom edge and end C/S area of beam  ok  all DOF  ok 

Select  ALL DOF arrested 

Define loads  Apply  Structural  Pressure  on areas  select the extreme right 

of web (20Mpa)  ok 

Define loads  Apply  Structural  Pressure  on areas  select the extreme left 

of web (-20 MPa)  ok 

Figure: Boundary and operating condition model 
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STEP 6: Solving the system 

Solution Solve  Current LS 

POSTPROCESSING: VIEWING THE RESULTS 
 

1. Deformation 

From the main menu select General post processing 

General post processing  Plot Results  Deformed Shape 
 

Select 'Def + undef edge' and click 'OK' to view both the deformed and the undeformed 

object 

 

Figure: Deformed and undeformed model 

Nodal solution 

From the Utility menu select PLOT 

PLOT Results Contour plot  Nodal solution 

2. Select DOF solution  Y component of rotation  OK 
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Figure: Y- component of rotation model 

3. Select DOF solution  X component of displacement  OK 
 

 
Figure: X- component of displacement model 

 
4. Select stress  YZ shear stress 
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Figure: YZ shear stress model 

 
5. Select stress  Von mises stress 

 

 

Figure: Von mises stress model 

RESULT: 

Case: 1:- To analyze Torsion of stiffened thin walled closed section beam which is 

subjected to a pressure of 20 MPa. 

1.   DMX = 0.255E-04 

2. DMX = 0.255E-04 

SMN = -0.261E-04 

SMX = 0.242E-05 

3.   DMX = 0.255E-04 
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SMX = 0.238E-04 

4.   DMX = 0.255E-04 

SMN = -0.344E+07 

SMX = 0.309E+07 

5.   DMX = 0.255E-04 

SMX = 0.285E+08 

 

 

 
 

PROBLEM DEFINITIONS DIFFERENT FROM JNTU TOPICS 

 
Case: 2:- To analyze Torsion of stiffened thin walled closed section beam which is 

subjected to a pressure of 21 MPa. 

DMX = 0.268E-04 

SMX = 0.299E+08 
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subjected to a pressure of 22 MPa. 

DMX = 0.280E-04 

SMX = 0.313E+08 

 

 
Case: 4:- To analyze Torsion of stiffened thin walled closed section beam which is 

subjected to a pressure of 23 MPa. 

DMX = 0.293E-04 

SMX = 0.327E+08 
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Case: 5:- To analyze Torsion of stiffened thin walled closed section beam which is 

subjected to a pressure of 24 MPa. 

DMX = 0.305E-04 

SMX = 0.341E+08 

 
 

 

 

 

 
Case: 6:- To analyze Torsion of stiffened thin walled closed section beam which is 

subjected to a pressure of 25 MPa. 

DMX = 0.318E-04 

SMX = 0.355E+08 
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EXERCISE PROBLEM 

Find the Torsional strength of a thin walled open section beam for the following 

1. Z Section 

2. T section 
 

Consider flange dimension as 30cms and web dimension as 30cms, and pressure of 30MPa 

consider the material as Aluminum and Steel. State which one will be more efficient to install. 

 

VIVA QUESTIONS 

 

1. Define stiffness. 

2. What are Boolean operations? 

3. Define truss? 

4. Name all the types of elements used in Ansys with example? 

5. What is Poisson’s ratio and give the steps for obtaining Poisson’s ratio value. 
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EXPERIMENT: 4 

2-D STATIC LINEAR ANALYSIS OF A TRUSS STRUCTURE 
 

 Statically indeterminate truss. 
 

AIM: To determine the nodal deflections, reaction forces, and stress of the indeterminate truss 

system when it is subjected to a load of 8000 N. (E = 200GPa, A = 3250mm2) 

PROCEDURE: 

PREPROCESSING 

STEP 1: From the Main menu select preferences 

Select structural and press OK 

STEP 2: From the main menu select Preprocessor 

Element type  Add / edit/Delete  Add  Link – 2D spar 8  ok close 

Real constants  Add  Geometric Properties  Area = 3250 

Material properties  material models  Structural  Linear  Elastic  Isotropic 

EX = 2e5; PRXY = 0.3 

STEP 3: From the main menu select Pre-processor  Modeling 

 Create the key points in the Workspace 

Pre-processor  Modeling  Create  Nodes  In active CS 
 

X Y Z 

0 0 0 

5 0 0 

10 0 0 

15 0 0 

2.5 2.5 0 

7.5 2.5 0 

12.5 2.5 0 

 

Click APPLY to all the points and for the last point click OK 

 
 Create LINES using the Elements 

 
Pre-processor  Modeling  Create  Elements  Auto numbered  through nodes 

 select node 1&2  apply 2&3  apply3&4  apply1&5  apply5&2 
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 apply 2&6  apply6&3 apply  3&7  apply  7&4  apply  5&6 

apply 6&7 ok  close 

Figure: Model 

SOLUTION PHASE: ASSIGNING LOADS AND SOLVING 

STEP 5: From the ANSYS main menu open Solution 

Solution  Analysis type  new analysis – Static 

STEP 6: Defining loads at the Key points 

Solution  Define Loads  Apply  Structural  Displacement  On nodes 

select node 1&4 ok  select All DOF  ok 

Left end – ALL DOF arrested 

Solution  Define loads  Apply  Structural  Force/moment  On nodes 

Select node 2&3  ok FY direction  Give force value as -8000N  ok  close 

 

Figure: Model with boundary conditions 
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STEP 7: Solving the system 

Solution Solve  Current LS 

POSTPROCESSING: VIEWING THE RESULTS 
 

1. Deformation 

From the main menu select General post processing 

General post processing  Plot Results  Deformed Shape 

Select 'Def + undef edge' and click 'OK' to view both the deformed and the undeformed 

object. 

 

Figure: Deformed and undeformed Model 

 
Nodal solution 

 
From the Utility menu select PLOT 

 
PLOT Results Contour plot  Nodal solution  DOF solution  Y component 

of displacement  OK 

 

RESULT: 
 

Case: 1:- To Determine the nodal deflections, reaction forces, and stress for the truss 

system shown below (E = 200GPa, A = 3250mm2). At load -8000N 

1. DMX = .461E-03 

SMN = -.461E-03 
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Figure: Y-Component displacement of the Model 

PROBLEM DEFINITIONS DIFFERENT FROM JNTU TOPICS 

Case: 2:- To Determine the nodal deflections, reaction forces, and stress for the truss 

system shown below (E = 200GPa, A = 3250mm2). At load -7000N 

2. DMX = .404E-03 

SMN = -.404E-03 
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Case: 3:- To Determine the nodal deflections, reaction forces, and stress for the truss 

system shown below (E = 200GPa, A = 3250mm2). At load -6000N 

77 

 

 

3. DMX = .346E-03 

SMN = -.346E-03 

 

 
Case: 4:- To Determine the nodal deflections, reaction forces, and stress for the truss 

system shown below (E = 200GPa, A = 3250mm2). At load -5000N 

4. DMX = .288E-03 

SMN = -.288E-03 
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Case: 5:- To Determine the nodal deflections, reaction forces, and stress for the truss 

system shown below (E = 200GPa, A = 3250mm2). At load -9000N 

 

5. DMX = .519E-03 

SMN = -.519E-03 

 
 

 

Case: 6:- To Determine the nodal deflections, reaction forces, and stress for the truss 

system shown below (E = 200GPa, A = 3250mm2). At load -10000N 

6. DMX = .577E-03 

SMN = -.577E-03 
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EXERCISE PROBLEM 

 

1. Find the forces and stresses in the members of the truss. 
 
 

 

 

VIVA QUESTIONS 

1. Ansys needs the final element model(FEM) for its final solution.(T/F) 

2. Element attributes must be set before meshing the solid model. (T/F) 

3. In a plane strain, the strain in the direction of thickness is assumed to be zero.(T/F) 

4. The elements are used for in-plane bending problems. 

5. Which one of the following elements is required to define the thickness as a real constant? 

a. Beam 

b. Shell 

c. Solid 

d. None 
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EXPERIMENT: 5 

MODAL ANALYSIS OF UNIFORM CANTILEVER BEAM 
 

 Free vibration of uniform cantilever beam. 
 

Aim: Analyze the given uniform cantilever beam using Ansys and find out the variation in the 

frequencies for 5 mode shapes. 

Apparatus: ANSYS Software 13.0 

Given Data: 

Young’s Modulus: 2e5 

Poisson’s Ratio: 0.27 

Length of the beam: 1000 

Steps of Modeling: 

Preferences ► Structural ► H- method ► OK 

Preprocessor ► Element Type ► Add ► Add ► 

Beam ► 2D elastic 3 ► Apply► OK 

Real constants ► add ► beam 3 ► Area = 1025 

► Izz = 450 

► thickness = 6 & width 25 mm 

Material Properties ► Material Models ► Structural ► Linear ► Elastic ► Isotropic ► 

EXX: 2e5 

PRXY: .27 

Density: 2870 

Modeling ► Create ► Key points ► In Active CS 
 

X Y Z 

1. 0 0 0 

2. 1000 0 0 

 
Pre-processor  Modelling  Create  Lines  Straight Line  Click on Key points to 

generate lines 
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Meshing the Geometry 
 

From the main menu select Meshing 

Meshing  Size controls  Manual size  Lines  All lines – Number of element 

divisions = 1  Click OK 

Meshing  Mesh  Lines – pick all 

 
Defining loads 

Loads ► Define Loads ► Apply ► Structural ► Displacement ► On nodes ► Select node 

1 ► Select All DOF ► OK 

Solution 

Loads ► Analysis Type ► New Analysis ► Select Modal ► OK 

Loads ► Analysis Option ► No.of Mode Shapes = 5 ► OK 

Enter the Start Freq = 0 

End Frequency = 0 ► OK 

Solution ► Solve ► Current LS ► Warnings can be ignored ► Solution is Done 

RESULTS: 

General Post Processor ► Read Results ► by Pick 

 
RESULT: 

 

Case: 1:- To determine the 1
st
 mode frequency acting on cantilever beam. 

 

 

DMX: 0.369e-04 
 

Frequency: 0.310e-05 
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PROBLEM DEFINITIONS DIFFERENT FROM JNTU TOPICS 

 
Case: 2:- To determine the 2

nd
 mode frequency acting on cantilever beam. 

 

 
DMX: 0.369e-04 

 

Frequency: 0.194e-04 

 
Case: 3:- To determine the 3

rd
 mode frequency acting on cantilever beam. 

 
 

 
DMX: 0.369e-04 

 

Frequency: 0.543e-04 
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Case: 4:- To determine the 3
rd

 mode frequency acting on cantilever beam. 
 
 

 
DMX: 0.369e-04 

 

Frequency: 0.106e-04 

 
Case: 4:- To determine the 3

rd
 mode frequency acting on cantilever beam. 

 
 

 
DMX: 0.369e-04 

 

Frequency: 0.176e-04 
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EXERCISE PROBLEM 

Perform the modal analysis of the same cantilevered beam under different isotropic material 

and state your observation. 

VIVA QUESTIONS 
 
 

1. Name the types of meshing. 

2. Explain the Main Steps involved in Ansys Programming. 

3. What is Modal Analysis? Write the Steps involved in Modal Analysis. 

4. How do you see the Animations of the Deformed Shapes in Ansys? 

5. Write the Procedure for finding the SFD & BMD of a Link. 
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EXPERIMENT: 6 

ANALYSIS OF A LANDING GEAR 
 

 

 3 dimensional landing gear trusses. 
 

Aim: Analyze the given landing gear structure with applied load of 10000N. 

Apparatus: Ansys Software 13.0 Version 

Given Data: 

Angle (Strut):60 degrees 

Poisson’s Ratio=0.3 

Steps of Modeling: 

Preferences ► Structural ► H-Method ► OK 
 

Preprocessor ► Element Type ► Add ► Add ► Select Link ► 2D spar 1 ► Apply 
 

Preprocessor ► Element Type ► Add ► Add ► Select Beam ► 2 Node 188 ► OK ► 

Close 
 

Real Constants ► Add ► Add ► Select Type Link 1 ► Click OK 

Enter the cross sectional area =1 ► OK ► Close 

Material Properties ► Material Models ► Structural ► Linear ► Elastic ► Isotropic 

Enter the Young’s Modulus (EXY) = 3e7 

Poisson’s Ratio (PRXY) = 0.3 
 

Sections ►Beam ►Common Sections ►Subtype ► Select Solid Circle 

R=0.5 

N=20 
 

T=0, Meshview 
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T=10, Mesh view,OK 

Right click,Replot. 

 
 

 

Preprocessor ► Modeling ► Create ► Key points ► In Active CS ► 

Create the keypoints according to the table 
 

KP no X Y Z 

1. 0 0 0 

2. -12 0 0 

3. 12 0 0 

4. 0 -12 0 

5. 0 -12-12 0 

6. 0 -12-12-12 0 
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Modeling ► Create ► Lines ► Lines ► Straight Lines ► 

Join the key points according to table 
 

Line no Join 

1. 1 & 4 

2. 4& 5 

3. 5& 6 

4. 2& 5 

5. 3& 4 

 

 
Preprocessor ► Meshing ► Mesh Attributes ► All lines ► 

Select element type Beam 188, Ok 

Meshing ► Mesh tool► set ►Global 

1Link1►Ok 

Lines►set►3&4 line click►2&5 line click►ok 

No of divisions 1►ok 

Mesh Tool►Mesh►Mesh only strut►ok 

Meshing ► Mesh tool► set ►Global 

2 Beam 188►Ok 

Lines►set►1&4 line click►4&5 line click►5&6 line click►ok 

Element egde length►1►ok 

Mesh Tool►Mesh►Mesh only Vertical line►ok 

 

 
Main menu► plot Cntrls ► Style ► Size and Shape 

Click in the box against Display Element Type, 
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Disable Display Element Type, 

 

 
Solution ► Define Loads ► Apply ► Structural ► Displacement ► On key Points ► 

Select keypoints 2 & 3►select UX,UY,UZ,ROTX,ROTY►Ok 

Select keypoints 2 & 3►select UX,UZ►Ok 

Modeling >Create>Nodes>Rotate nodes CS>By angles>click 6th keypoint 

THXY >60>ok 

Loads>Apply>Structural>Force/Moment>click On nodes 28/Key point 6> 

Force/Moment value >10000 

 

 

 
Solution ► Solve>General Post proc>List results>Rection solution> 

Plot results:Defromed shape 
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Plot results: >nodal solution>DOF solution>Displacement vector sum>ok 

Plot ctrls> Click in the box against Display Element Type>ok 

 
 

 

 

 

Result: 
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EXERCISE PROBLEM 

Analyze the given landing gear as shown in the below figure structure with applied load of 

10000N. 

Angle (Strut):30 degrees 

Poisson’s Ratio=0.3 

VIVA QUESTIONS 

1. Name the element type used for beams? 

2. Define Analysis and its Purpose? 

3. What are the modules in Ansys Programming? 

4. What are the Real Constants & Material Properties in Ansys? Explain? 
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EXPERIMENT: 7 

STATIC ANALYSIS OF TAPERED WING BOX 
 

 

Aim: Analyze the given wing structure using Ansys and find out the variation in the Structure 

of the Wing. 

Apparatus: ANSYS Software 13.0 

Given Data: 

Young’s Modulus: 7e10 

Poisson’s Ratio: 0.3 

Length of the Wing: 30 

Steps of Modeling: 

Preferences ► Structural ► H- method ► OK 

Preprocessor ► Element Type ► Add ► Add ► 

Solid ► Brick 8 Node 45 ► Apply 

Beam ► 2 node 188 ► Apply ► 

Shell ► elastic 4 node 63 ► Click OK 

Real constants ► Add ► shell 63 ► I = 1.2, j = 1.7, k = 2.2 

Material Properties ► Material Models ► Structural ► Linear ► Elastic ► Isotropic ► 

EXX: 7e10 

PRXY: 0.3 

Density: 2700 

Modeling ► Create ► Key points ► In Active CS 
 

X Y Z 

1.   0 0 0 

2.   8 4 0 

3.   8 -4 0 

4.   -6 3 0 

5.   -6 -3 0 
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6. 6 3 30 

7. 6 -3 30 

8. -4 -2 30 

9. -4 2 30 
 

Modeling ► Create ► Lines ► straight lines ► 2, 3 - 2, 4 - 4, 5 - 5, 3 ► Apply 

Lines ►6, 8 - 6, 7 - 7, 9 - 8, 9 ► Apply 

Lines ► 8, 4 & 9, 5 

Lines ► 2, 6 & 7, 3 ► OK 

Modeling ► Create ► Areas ► Arbitrary ► by lines ► Select Upper Lines of Both sides ► 

Left Line, Right Lines ► Click Apply ► Select Lower Lines of both the sides ► Left Line 

and Right Line Click Apply ► Click OK 

Modeling ► Create ► Volumes ► Arbitrary ► by Areas ► Box Selection ► Select all the 

Areas ► Click OK ► Hence a Solid Volume is created 

Meshing ► Mesh Attributes ► all lines ► Select beam 188 ► OK 

Meshing ► Mesh Attributes ► All Areas ► Select shell 63 ► OK 

Meshing ► Mesh Attributes ► All Volumes ► Select solid 45 ► OK 

Meshing ► Size control ► manual size ► pick all lines ► Enter the Element Edge Length as 

1 ► OK 

Meshing ►size control ► areas ► Box Selection ► Enter the Element Edge Length as 1 ► 

OK 

Meshing ► Mesh ► Volumes ► free ► Select the box ► select full body ► OK 

Loads ► Define Loads ► Apply ► Structural ► Displacement ► On Areas ► Select the 

Large Airfoil Area ► Click Apply ► Select All DOF ► OK 

Loads ► Define Loads ► Apply ► Structural ► Pressure ► On Areas ► Select the upper 

and lower surface ► Click Apply ► Enter the Load Value =10000N & -10000N 

Loads ► Analysis Type ► New Analysis ► Select Static ► OK 

Solution ► Solve ► Current LS ► Warnings can be ignored ► Solution is done 

RESULTS: 

General Post Processor ► Plot Results ► Deformed Shape ► Deformed + Undeformed ► 

OK 

General Post Processor ► Plot Results ► Contour Plot ► Nodal Solution ► DOF Solution 
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Case: 1:- To determine the stresses acting on a tapered wing with a pressure load of 

10000 & -10000 N acting on the lines upper and lower surfaces. 

 

Y Component of Displacement = 0.527e-04 

Von Mises Stress = 338872 
 

 

 

 
PROBLEM DEFINITIONS DIFFERENT FROM JNTU TOPICS 

Case: 2:- To determine the stresses acting on a tapered wing with a pressure load of 

12000 & -12000 N acting on the lines upper and lower surfaces. 

 

Y Component of Displacement = 0.633e-04 

Von Mises Stress = 406647 
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Case: 3:- To determine the stresses acting on a tapered wing with a pressure load of 

14000 & -14000 N acting on the lines upper and lower surfaces. 

 

Y Component of Displacement = 0.738e-04 

Von Mises Stress = 474421 
 

 

 
Case:4:- To determine the stresses acting on a tapered wing with a pressure load of 16000 

& -16000 N acting on the lines upper and lower surfaces. 

 

Y Component of Displacement = 0.844e-04 

Von Mises Stress = 542196 
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Case: 5:- To determine the stresses acting on a tapered wing with a pressure load of 

10000 & -10000 N acting on the lines upper and lower surfaces. 

 

Y Component of Displacement = 0.949e-04 

Von Mises Stress = 609970 
 

 

 

Case: 6:- To determine the stresses acting on a tapered wing with a pressure load of 

10000 & -10000 N acting on the lines upper and lower surfaces. 

 

Y Component of Displacement = 0.105e-03 

Von Mises Stress = 677744 
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EXERCISE PROBLEM 

1. Modal Analysis of a airplane wing 

 
VIVA QUESTIONS 

 

 

1. The analysis is used to calculate the vibration characteristics of a structure. 

2. The SI unit of frequency is . 

3. Ansys report is saved with the file extension. 

4. The images captured using the Ansys report generator are saved with a   

extension. 

5. The maximum stress value should be less than the applied stress bound value. (T/F) 
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EXPERIMENT: 8 

ANALYSIS OF A FUSELAGE 
 

 

 Fuselage bulkhead. 

 
AIM: - To Calculate the deformation of the aluminum fuselage section under the application 

of internal load of 100000 Pa. 

PREPROCESSING 

STEP 1: From the Main menu select preferences 

Select structural and press OK 

STEP 2: From the main menu select Pre-processor 

Element type  Add / edit/Delete  Add  Solid – 10 node 92 Apply 

Add  Beam 2 Node 188  Apply  Add  Shell Elastic 4 node 

63 
 

 

Real Constants  Add  Select shell  give thickness (I) = 1 ok  close. 

Material properties  material models  Structural  Linear  Elastic  Isotropic 

EX = 0.7e11; PRXY = 0.3; Density = 2700 

STEP 3: From the main menu select Pre-processor 

Pre-processor  modelling  Create  Areas  Circle  Annulus 

WP x = 0 ; WP y = 0; Rad – 1 = 2.5; Rad -2 = 2.3 OK 

Pre-processor  Modelling  Create  Circle  Solid – 

WP x = 0; X = 2.25; Y = 0 Radius = 0.15 Apply 

WP x = 0; X = -2.25; Y = 0 Radius = 0.15 Apply 

WP x = 0; X =0; Y = 2.25; Radius = 0.15 Apply 

WP x = 0; X = 0; Y = -2.25 Radius = 0.15 OK 

Pre-processor  Modelling  Operate  Booleans  Add  Areas – Pick all OK 

Pre-processor  Modelling  Operate  Extrude  Areas  By XYZ offset 

X= 0; Y=0; Z = 5 
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STEP 4: Meshing the Geometry 
 

Pre-processor Meshing  Size controls  Manual Size  All Areas  give element 

edge length as 0.15  ok 

Meshing  Size controls  Manual Size  All lines  give element edge length as 

0.15  ok 

Meshing  Mesh  areas  free  select box type instead of single  select the total 

volume  ok 

 

SOLUTION PHASE: 

 

STEP 5: From the ANSYS main menu open Solution 

STEP 6: Loads  define loads  Apply  Structural  Displacement  On areas 

 select box type  select box (4 points at centre)  all DOF  ok Select  ALL 

DOF arrested 

Define loads  Apply  Structural  Pressure  on areas  select the internal 

surface of the fuselage and give value (100000)  ok 



CS Lab Manual Dept. of ANE 

106 

 

 

STEP 7: Solving the system 

Solution Solve  Current LS 

POSTPROCESSING: VIEWING THE RESULTS 

RESULT: 

Case: 1:- To Calculate the deformation of the aluminum fuselage section under the 

application of internal load at 1e5. 

 

Y COMPONENT OF DISPLACEMENT 
 

DMX = .194E-04 

SMN = -.194E-04 

SMX = .194E-04 

VON MISSES STRESS 
 

DMX = .194E-04 

SMX = .124E+07 

 

 
PROBLEM DEFINITIONS DIFFERENT FROM JNTU TOPICS 

 
Case: 2:- To Calculate the deformation of the aluminum fuselage section under the 

application of internal load at 1.1e5. 

 

Y COMPONENT OF DISPLACEMENT 
 

DMX = .819E-05 

SMN = -.819E-05 

SMX = .819E-05 

VON MISSES STRESS 
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DMX = .819E-05 

SMX = 559474 

 

 

 

 

 

 

 

 

 

 

Case: 3:- To Calculate the deformation of the aluminum fuselage section under the 

application of internal load at 1.2e5. 

 

Y COMPONENT OF DISPLACEMENT 

 
DMX = .893E-05 

SMN = -.893E-05 

SMX = .893E-05 

VON MISSES STRESS 
 

DMX = .893E-05 

SMX = 610335 

 

 

 

 

 

 

 

 

 

 
Case: 4:- To Calculate the deformation of the aluminum fuselage section under the 

application of internal load 0.9e5. 

 

Y COMPONENT OF DISPLACEMENT 

DMX = .670E-05 

SMN = -.670E-05 
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SMX = .670E-05 

VON MISSES STRESS 
 

DMX = .670E-05 

SMX = 457751 

Case: 5:- To Calculate the deformation of the aluminum fuselage section under the 

application of internal load at 0.8e5. 

 

Y COMPONENT OF DISPLACEMENT 

 
DMX = .595E-05 

SMN = -.595E-05 

SMX = .595E-05 

VON MISSES STRESS 
 

DMX = .595E-05 

SMX = 406890 
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Case: 6:- To Calculate the deformation of the aluminum fuselage section under the 

application of internal load at 0.7e5. 

 

Y COMPONENT OF DISPLACEMENT 
 

DMX = .521E-05 

SMN = -.521E-05 

SMX = .521E-05 

VON MISSES STRESS 
 

DMX = .521E-05 

SMX = 356029 

 

 

 

 

 

 

 

 

 

 

 
EXERCISE PROBLEM 

 

1. Static analysis of pressure vessel. 

VIVA QUESTIONS 

1. Difference between interactive mode and batch mode. 

2. What are different types of structural analysis used in ansys? 

3. What are the different types of thin walled beams? 

4. Define Harmonic analysis. 

5. Define Spectrum Analysis. 
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	EXPERIMENT: 2
	COMPRESSIVE STRENGTH OF RECTANGULAR STIFFENED PLANE PANEL OF UNIFORM CROSS-SECTION
	 Nodal solution
	PROBLEM DEFINITIONS DIFFERENT FROM JNTU TOPICS
	Case: 3:- To determine the stresses acting on a rectangular plane with a pressure load of 10000 N acting on the lines 2 & 3
	Case: 4:- To determine the stresses acting on a rectangular plane with a pressure load of 13000 N acting on the lines 2 & 3
	Case: 5:- To determine the stresses acting on a rectangular plane with a pressure load of 14000 N acting on the lines 2 & 3
	Case: 6:- To determine the stresses acting on a rectangular plane with a pressure load of 15000 N acting on the lines 2 & 3
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	EXPERIMENT: 3(A)
	a) SHEAR OF STIFFENED THIN WALLED OPEN SECTION BEAM
	Figure: Open section beam meshed model SOLUTION PHASE: ASSIGNING LOADS AND SOLVING
	Figure: Deformed and undeformed model
	Figure: X-Component of displacement model
	Figure: XY shear stress model
	Figure: Von mises stress model
	Case: 1:- To analyze shear of stiffened thin walled open section beam which is subjected to a pressure of 50 MPa.
	PROBLEM DEFINITIONS DIFFERENT FROM JNTU TOPICS
	Case: 3:- To analyze shear of stiffened thin walled open section beam which is subjected to a pressure of 52 MPa.
	Case: 4:- To analyze shear of stiffened thin walled open section beam which is subjected to a pressure of 53 MPa.
	Case: 5:- To analyze shear of stiffened thin walled open section beam which is subjected to a pressure of 54 MPa.
	Case: 6:- To analyze shear of stiffened thin walled open section beam which is subjected to a pressure of 55 MPa.
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	TORSIONAL STRENGTH OF A THIN WALLED OPEN SECTION BEAM
	Figure: Open section beam meshed model SOLUTION PHASE: ASSIGNING LOADS AND SOLVING
	Figure: Deformed and undeformed model
	Figure: Y- component of rotation model
	Figure: X- component of displacement model
	Figure: YZ shear stress model
	Figure: Von mises stress model
	Case: 1:- To analyze Torsion of stiffened thin walled open section beam which is subjected to a pressure of 20 MPa.
	PROBLEM DEFINITIONS DIFFERENT FROM JNTU TOPICS
	Case: 3:- To analyze Torsion of stiffened thin walled open section beam which is subjected to a pressure of 22 MPa.
	Case: 5:- To analyze Torsion of stiffened thin walled open section beam which is subjected to a pressure of 24 MPa.
	Case: 6:- To analyze Torsion of stiffened thin walled open section beam which is subjected to a pressure of 25 MPa.
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	EXPERIMENT: 3 (C)
	SHEAR FORCE OF STIFFENED THIN WALLED CLOSED SECTION BEAM
	Figure: Closed section beam meshed model SOLUTION PHASE: ASSIGNING LOADS AND SOLVING
	Figure: Deformed and undeformed model
	Figure: Y-Component of displacement model
	Figure: XZ shear stress model
	Figure: Von mises stress model
	Case: 1:- To analyze shear of stiffened thin walled closed section beam which is subjected to a pressure of 50 MPa.
	PROBLEM DEFINITIONS DIFFERENT FROM JNTU TOPICS
	Case: 4:- To analyze shear of stiffened thin walled closed section beam which is subjected to a pressure of 53 MPa.
	Case: 5:- To analyze shear of stiffened thin walled closed section beam which is subjected to a pressure of 54 MPa.
	Case: 6:- To analyze shear of stiffened thin walled closed section beam which is subjected to a pressure of 55 MPa.
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	TORSIONAL STRENGTH OF A THIN WALLED CLOSED SECTION BEAM
	Figure: Closed section beam meshed model SOLUTION PHASE: ASSIGNING LOADS AND SOLVING
	Figure: Boundary and operating condition model
	Figure: Deformed and undeformed model
	Figure: Y- component of rotation model
	Figure: X- component of displacement model
	Figure: YZ shear stress model
	Figure: Von mises stress model
	Case: 1:- To analyze Torsion of stiffened thin walled closed section beam which is subjected to a pressure of 20 MPa.
	PROBLEM DEFINITIONS DIFFERENT FROM JNTU TOPICS
	subjected to a pressure of 22 MPa.
	Case: 4:- To analyze Torsion of stiffened thin walled closed section beam which is subjected to a pressure of 23 MPa.
	Case: 5:- To analyze Torsion of stiffened thin walled closed section beam which is subjected to a pressure of 24 MPa.
	Case: 6:- To analyze Torsion of stiffened thin walled closed section beam which is subjected to a pressure of 25 MPa.
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	Figure: Model SOLUTION PHASE: ASSIGNING LOADS AND SOLVING
	Figure: Model with boundary conditions
	Figure: Deformed and undeformed Model
	Figure: Y-Component displacement of the Model PROBLEM DEFINITIONS DIFFERENT FROM JNTU TOPICS
	Case: 4:- To Determine the nodal deflections, reaction forces, and stress for the truss system shown below (E = 200GPa, A = 3250mm2). At load -5000N
	Case: 5:- To Determine the nodal deflections, reaction forces, and stress for the truss system shown below (E = 200GPa, A = 3250mm2). At load -9000N
	Case: 6:- To Determine the nodal deflections, reaction forces, and stress for the truss system shown below (E = 200GPa, A = 3250mm2). At load -10000N


	EXPERIMENT: 5
	MODAL ANALYSIS OF UNIFORM CANTILEVER BEAM
	DMX: 0.369e-04
	PROBLEM DEFINITIONS DIFFERENT FROM JNTU TOPICS
	DMX: 0.369e-04 (1)
	Case: 3:- To determine the 3rd mode frequency acting on cantilever beam.
	Frequency: 0.543e-04
	DMX: 0.369e-04 (2)
	Case: 4:- To determine the 3rd mode frequency acting on cantilever beam.
	Frequency: 0.176e-04
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	ANALYSIS OF A LANDING GEAR
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	EXPERIMENT: 7
	STATIC ANALYSIS OF TAPERED WING BOX
	Case: 1:- To determine the stresses acting on a tapered wing with a pressure load of 10000 & -10000 N acting on the lines upper and lower surfaces.
	PROBLEM DEFINITIONS DIFFERENT FROM JNTU TOPICS
	Case: 3:- To determine the stresses acting on a tapered wing with a pressure load of 14000 & -14000 N acting on the lines upper and lower surfaces.
	Case:4:- To determine the stresses acting on a tapered wing with a pressure load of 16000 & -16000 N acting on the lines upper and lower surfaces.
	Case: 5:- To determine the stresses acting on a tapered wing with a pressure load of 10000 & -10000 N acting on the lines upper and lower surfaces.
	Case: 6:- To determine the stresses acting on a tapered wing with a pressure load of 10000 & -10000 N acting on the lines upper and lower surfaces.
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	Y COMPONENT OF DISPLACEMENT
	VON MISSES STRESS
	PROBLEM DEFINITIONS DIFFERENT FROM JNTU TOPICS
	Y COMPONENT OF DISPLACEMENT (1)
	VON MISSES STRESS (1)
	Case: 3:- To Calculate the deformation of the aluminum fuselage section under the application of internal load at 1.2e5.
	VON MISSES STRESS (2)
	Case: 4:- To Calculate the deformation of the aluminum fuselage section under the application of internal load 0.9e5.
	VON MISSES STRESS (3)
	Case: 5:- To Calculate the deformation of the aluminum fuselage section under the application of internal load at 0.8e5.
	VON MISSES STRESS (4)
	Case: 6:- To Calculate the deformation of the aluminum fuselage section under the application of internal load at 0.7e5.
	VON MISSES STRESS (5)
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